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HP Automation Insight: Migrate BSAE Universes and Reports

You can migrate your HP BSA Essentials 9.x release SAP BusinessObjects universes and reports to HP
Automation Insight (Al). This enables you to run and view your BSAE reports in HP Automation Insight.

Migrating BSAE universes and reports should be done only by the Administrator user.

Before You Begin

Before you can migrate BSAE universes and reports to HP Al, BSAE must be up and running and HP Al
must be installed.

Perform the following tasks to migrate your BSAE universes and reports to HP Al:

Install the BO 3.0 Client Tools

Import the BIAR File from the BSAE Server

Run the Upgrade Management Tool on the HP Al Core Server

Install the BO 4.0 Client Tools

Update the oracle.sho File

Create the BSAE-JDBC Connection

Restart the SAP BusinessObjects Services on the HP Al Core Server
Run Migrated Reports

©No gk whE

Install the BO 3.0 Client Tools

The Import Wizard is a client tool provided by SAP BusinessObijects to create or deploy Business
Intelligence Archive Resource (BIAR) files. The Import Wizard provides a series of screens that guides
you through the process of importing and exporting Business Intelligence content such as user accounts,
groups, folders, reports, and universes. Various dialog boxes and user screens may appear depending on
the source environment and the types of information that you choose to import. SAP BusinessObjects
client tools such as Designer and Import Wizard are part of the BO client tools. BO client tools are
shipped with HP Al.

BSAE on Linux and the Import Wizard

The SAP BusinessObijects client tools are available for Windows platforms. Please install
BusinessObijects client tools on a windows system such as a desktop or laptop.

1. Copythe BO3SP3ClientTools-3.0.3.zip file from the HP Al core server to the windows
system. The BO3SP3ClientTools-3.0.3.zip file can be found on disk 5 of the electronic
distribution.

2. Create a folder “BO-Client-Tools-3.0” and unzip the BO3SP3ClientTools-3.0.3.zip file to
this folder.

3. Runthe setup.exe file present in the “BO-Client-Tools-3.0” folder.

Import the BIAR File from the BSAE Server

Use the SAP BusinessObjects Import Wizard to import the BSAE Business Intelligence Archive Resource
(BIAR) file and save it in a local folder.
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Use the Import Wizard to Create a BIAR File

1. On the windows system, select Start > All Programs - Business Objects XI 3.1 > Business
Objects Enterprise Client Tools - Import Wizard

The Import Wizard opens:

_-:FJ Import Wizard

(o |

Language : [EET IR~ |

m Welcome to the Import Wizard

This wizard helps you import information from Crystal Enterprise
or BusinessObjects Enterprise into your curmernt
BusinessObjects Erterprise deployment. You will need to:

* Select a source environment
* Select a destination environment
# Select users and objects to impart

Throughout this wizard, you can move to the next page by
clicking Next, or retum to a previous page by clicking Back.

To begin importing cortert, click Mesd.

=
A
W

Cancel Help

h
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2. Click Next. The Source Environment window opens.

ﬁ Import Wizard

[t

Source environment

Select an exdsting environment from which the Wizard will impart user/group and
object folder information .

[

Source:

BusinessOhbjects Enterprise ¥l 3x -

@' and password.

CM5 Mame:

User Name:
Password:

Authentication:

Enter the name of the source CMS. You also need to specify your user name

|1E.1EE.43.1DE

I.ﬂu:lministlatur

I

I Enterprise ;I

< Back Nest > Cancel

Help

3. Enter the IP address of the BSAE 9.x source server in the CMS Name field.

4. Enter the Administrator user name and password.

HP Automation Insight
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5. Click Next. The Destination Environment window opens.

:_-:bJ Import Wizard

Destination environment
Select the destination environment to which the Wizard will export content.

Destination: |Business Inteligence Archive Resource (BIAR) File

BIAR file: |C:"-.F'n:|g|am Files £26)"Business Objects\BSAEN

< Back | Nexst = | Cancel |

EE Specify the Business Inteligence Archive Resource file you want to export to...
B dl

Help

6. Select Business Intelligence Archive Resource (BIAR) File from the Destination pull-down

menu.
7. Browse to the target file location in the file system and select the BIAR file.
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8. Click Next. The Select objects to import window opens.

:_-:bJ Import Wizard

Select objects to import
Select the objects to import.

The Import Wizard enables you to select objects from the source environment to import
to the destination environment. Select one or more categories below to impart.

Import inbox documents
Impart personal categones
Impar favarte folders for selected users
Impart application rights
Impart root folder rights
Import comporate categories
Impart folders and objects

A Imnart annlication folders and ohiects

Select Al | Clear Al

Import discussions associated with the selected reports

< Back et >

m

Help
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9. Select all options except for “Import remote connections and replication jobs.”
10. Click Next. Read the note that appears carefully.

:_-:FJ Import Wizard

A note on impeorting server groups

You have chosen to import server groups from the source environment.

you will need to manually add the desired servers to the imported server groups.

dependent on the server group from running successfully.

< Back Cancel

Failure to do so will render the server groups invalid, which will prevent any reports

Server groups are imported without their member servers. After importing is complete,

Help
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11. Click Next. The Users and groups window opens.

‘%] Import Wizard ﬁ
Users and groups
Select the users or groups you want to import by clicking the box beside the tem. Ta m
select groups withaut selecting users, hold down SHIFT and click the groups.
Groups: Users:
El--@ hyillillbsachost08.ind hp.com:6400 « IM€% Administrator
~[A€R AAA Intemal @100
- J€R Administrators L
7 Everyone I
- [F€R Everyone@100
- [AR Guests@100
E CGaaW's Group Designer
B ) | ? Beannt Crnvarsinn Trnl | leam w7
4 T 3
Clear All
I+ Show groups hierarchically
I Select groups that contain selected users
< Back Mead = Cancel Help

12. Select the user groups including any custom groups that you created in your environment.

Note: Do not select the “Administrators” group or SA users when importing the BIAR file as this will over-
write the HP Al Administrator password.
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13. Click Next. The Custom Access Levels window opens.

ﬁ Import Wizard u

Custom Access Levels m

Select Custom Access Levels to import

~[Ji BSAE Management
g,i BSAE Read
g,i BSAE Schedule
Dgi BSAE Write
in Full Control
in Schedule

in View

View On Demand

Select Al | Clear Al Il

< Back Next > Cancel Hep |
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14. Click Next. The Categories window opens.

ﬁ Import Wizard ﬁ

Categories
Select the categores you wart to impart. m

= '= hyil1Irlbsachost 08 ind hp.com:6400 (BusinessObjects Enterprise X1 3x)

2 =-[J& Cortent Indexing Failures
- J& Excluded from Content Search I
Select Al Clear All

[T Import all objects that belong to the selected categories.

< Back Nest » Cancel Help
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15. Click Next. The Folders and objects window opens.

:_-:bJ Import Wizard Iﬁ

Folders and objects
Select the folders and objects you want to import by clicking the box beside the item. m

El@ hyi01IrDbsashost 30ind hp.com:6400 (BusinessObjects Enterprise X 3x)
|:| BSAE
[#]_1 HPSA Compliance

' W8] HPSA Invertory

DI:I Report Conversion Tool

Select Al Clear All

| Import all instances of each selected object

< Back Mead = Cancel Help

16. Select the source folders and objects you want to import.

Note: When you select the reports and objects to import, the Import Wizard identifies the folder hierarchy.
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17. Click Next. The Select application folders and objects window opens.

ﬁ Import Wizard u

Select application folders and objects m

Select the application folders and objects you want to import. f the selected folders and
ohjects exist on destination system, they will be updated using the sounce system as a
reference.

i1 hyi0 Tir0bsaehost 08.nd hp.com 6400 (BusinessObjects Enterprise X| 3x)
DI:I CommenConnections

DI:I Maobile Cffline Data

DI:I Mobile Subscriptions Folder

DI:I CQaaWs Folder

Select Al Clear All

< Back Nest » Cancel Help
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18. Click Next. The Import objects for universes and connections window opens.

r:_-:bJ Import Wizard l&

Import options for universes and connections m
[
Select an importing option for universe ohjects:
" mport all universes and all connection objects.
[ {" Import all universe and only connection objects used by these universes.
I

dmport the universes and connections that the selected Web Intelligence and
I {+ {Desktop Inteligence documents use directly. In the next dialog box, you can |
select additional universes that are not used by any imported document. i

N
| Select the following option i you want universe overdoads to be migrated with the
| Universes.

Iv¥ Keep universe overloads for imported users and groups

< Back et = Cancel Help

19. Select the third option.
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20. Click Next. The Universe folder and universes window opens.

:_-:bJ Import Wizard

S

Universe folder and universes

I Select the universe folders and universes you want to import by selecting the box beside
the item.

= @ h"_|'1|]'1|l'[“:lSE|E|‘|DSt (08.ind. hp com: 6400 (BusinessObjects Enterprise X 3x)

B
= NP-. Geneml Universe

.aj SA Compliance Universe

- [F#] SA General Universe

- D[:l Report Conversion Toal Universes

Select Al Clear All

< Back et = Cancel

®

Help

21. Select the BSAE Universes folder and select any user created folders.

HP Automation Insight
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22. Click Next. The Import repository object options window opens.

:_-:bJ Import Wizard

Import repository object options.
Choose an option to import selected reports that use repository objects.

Select an importing option for repository objects:

" Import all repository objects.

~ Import only repository objects that the selected reports use directly. (Waming:

this may affect business view abject integrity)

= dmport repository objects that the selected reports use directly, as well as any
iother repository objects they depend on.

< Back et = Cancel

Help

23. Select the third option.

HP Automation Insight
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24. Click Next. The Import options for publications window opens.

:_-:FJ Import Wizard

Import options for publications.

Select import option for importing profiles.

" Import profiles used by selected publications.

Select import option for importing publication recipients.

{* |mport recipierts used by selected publications.

(" Do not import recipients.

< Back Mext =

Cancel

Help

25. Select Import all profiles and Import recipients used by selected publications.

HP Automation Insight
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26. Click Next until the Ready to import wizard opens.

_-:FJ Import Wizard

Ready to import

The Import Wizard will now import all selected objects.

Selected objects to import

ﬁ 8 Groups selected

2 Users selected

(£130 Folders selected

Lh 0 Object packages selected
0 Objects selected

[ 0 Shortcuts selected

@ 0 Events selected

@ (0 Server groups selected

[4 0 Repository objects selected
M N Colandare salantad

Click Finish to begin importing information to the destination
erviranment.

Cancel

< Back

m

Help

27. Verify the list of objects selected for BIAR creation. Click Finish to complete the BIAR file export.

HP Automation Insight
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:_-:FJ Import Wizard 2

Doodse o ieeousck

il |
rogres

Import progress:

Impaort summary:

Impart Info | Wamings | *
ﬁ 8 of 8 Groups imparted (0 wamings) N
7 2of 2 Users imported (0 wamings)

C129 of 30 Folders imported (0 wamings) =

L 0 of 0 Object packages imported (0 wamings)

0 of 0 Objects imported {0 wamings)

,@ 0 of 0 Shortcuts imported (0 wamings)
E 0 of 0 Events imported (0 wamings)
ﬁ 0 of 0 Server Groups imported (0 wamings)
(340 of 0 Repository objects imported (0 wamings)
BR 0 of 0 Calendars imported (0 wamings)
T 1 3 of 3 Universes imported (0 wamings) &

View Detail Log | Done |

i

< Back | Finish | Cancel | Help |

28. Click View the Detail Log and review the import information.

29. Click Done to complete the BIAR creation process. The BIAR file is generated in the specified
location.

30. Copy the BSAE BIAR file to the target HP Automation Insight core server.

Run the Upgrade Management Tool on the HP Al Core Server

Type the following command to run the Upgrade Management Tool (UMT) to upgrade the BSAE BIAR file
to Bl 4.0 SP7:

/opt/HP/CBI/businessobjects/sap bobj/enterprise xi40/linux x64/jdk/jre/bin/ja
va -Xmx2g -
Djava.library.path="/opt/HP/CBI/businessobjects/sap bobj/enterprise xi40/java
/apps/upgradeManagementTool/jars" -Djava.io.tmpdir=<temp dir> -jar
"/opt/HP/CBI/businessobjects/sap bobj/enterprise xi40/java/apps/upgradeManage
mentTool/Jjars/upgrademanagementtool.jar" -mode biartolive -biarfile

<BSAE BIAR FILE PATH> -destination <AI Core IP:CMS_PORT> -destinationusername
"Administrator" -destinationpassword <administrator-password> -logfile

<log file path>
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Install the BO 4.0 Client Tools

The SAP BusinessObijects client tools are available for Windows platforms. Please install the SAP
BusinessObijects client tools on a windows system such as a desktop or laptop.

Perform the following steps to install the BO 4.0 client tools:

1.

Copy the BO4SP7ClientTools-4.0.7.zip file from the HP Al core server to the windows
system.

Create a folder “BO-Client-Tools-4.0” and unzip the BO4SP7ClientTools-4.0.7.zip file to
this folder.

Run the setup.exe file present in the “BO-Client-Tools-4.0” folder.

Update the oracle.sbo File

Perform the following steps to update the oracle.sbo file:

1.

Copy the
/opt/HP/CBI/businessobjects/sap bobj/enterprise xi40/dataAccess/connect

ionServer/jdbc/ojdbc6-11.2.0.3.0.jar file from the HP Al core server to the
“C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects
Enterprise XI 4.0\dataAccess\connectionServer\jdbc” directory where the 4.0
client tools are installed.

Gotothe C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects
Enterprise XI 4.0\dataAccess\connectionServer\jdbc directory.

Add “OJDBC driver” file path to the Class Path in the oracle. sbo file as shown below. Add the
following content to the oracle. sbo file under the “Oracle 11" node.

<Class
JARFile="dbd oracle">com.sap.connectivity.cs.java.drivers.jdbc.oracle.O
racleDriver</Class>

<JDBCDriver>
<ClassPath>
<Path>$ROOTS/drivers/java/dbd jdbcwrapper.jar</Path>

<Path> C:\Program Files (x86) \SAP

BusinessObjects\SAP BusinessObjects Enterprise XI
4.0\dataAccess\connectionServer\jdbc\ o0jdbc6-11.2.0.3.0.jar

</Path>
</ClassPath>

<Parameter Name="JDBC
Wrapper">com.sap.connectivity.cs.java.drivers.jdbc.wrapper.JDBCWrapper<
/Parameter>

</JDBCDriver>
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Create the BSAE-JDBC Connection

Perform the following steps to create the BSAE-JDBC connection:

1. Open the Universe Design Tool from Start->Programs->SAP Business Intelligence—>
Universe Design Tool.
2. Enter the login credentials of the HP Al core server administrator user.

3. Click OK.
User Identification u
—57
SAP BusinessObjects

Enter your name and password to log in.

System 16.166.449. 197 ;|

Uszer Mame: I administrator

Password: I —

Authentication IEnterprise ;I
oK I Cancel Help |
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4. Create a BSAE-JDBC connection object and create the associations between the BSAE
universes and the BSAE-JDBC connection. Select Tools - Connections from the Universe
Designer Tool menu. The connection panel window opens.

4L Connection Panel g

w| 8| o|a|x| x|a|mEl v|= B

Name | Type | Network Layer I Database E... | Folder I

': |BSAE-IDBC  Secured IDBC Orade 11 /

‘]B CBI_CON... Secured JDBC Vertica JDBC f

‘]D CBI_Test_... Secured JDBC Vertica JDBC /

# Conversio... Secured Orade OCI Oradle 10 /

# efashion Secured ODBC MS Access 2... [

# efashion-... Secured ODBC MS Access 2... [

Close Cancel Help I

! B T
Ll::_  — =
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5. Click the Create New Connection (Q) icon. The New Connection Wizard opens.

) Define a new connection

Mfaﬂwmmﬁon
Connection Type - | Secured =)
|| Connection Name: [BSAEJDEC]
| Connection Folder: [ =]

|
|'| Connection Description:

6. Enter BSAE-JDBC in the Connection Name field.
7. Click the folder (D) icon to select the location to store the BSAE-JDBC connection.
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8. Click Next. The Database Middleware Selection window opens.

D Dcfe 2 cev connccton SN —

Fitter On: I‘-Ienu:h:ur j

o] ale] |

&L gy Ingres -
L g Microsoft

&L g Metezza

El-L s Oracle

A [ Hyperion Essbase 7
- [J Hyperon Essbase 9
-0 MySQLE

7 [0 Oracle 10

=0 Oracle 11

. .7 JDBC Drivers
- [0 Oracle Exadata

4

[~ Fitter stored procedure network layer

< Back Mext = Cancel Help

9. Select the Oracle 11 JDBC Dirivers.
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10. Click Next. The Login parameters window opens.

i) Edit BSAE-JDBC connection

 using JDOBC middleware

|
| UserName [emdo_sdmin
"
|
|

Password P

Server(s) (host port{ host port}) [16.165 45.209:.1521)

Net Service [bsaedb

11. Enter the Database credentials and IP address, and the name of the database for the BSAE
database server. If the BSAE server is a single server, enter the core server details. If the BSAE

server is in a dual server configuration, specify the BSAE database server details. Do not use
“Admin” as the User Name.
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12. Click Next. The Configuration Parameters window opens.

# Edit BSAE-JDBC connection

database using JOBC

Connection Pool Mode

Poal Timeaout

Amay Fetch Size

Amay Bind Size

Login Timeout

Queny Timeout

JOBC Driver Properties (key=value key=value)

IHee-p the connection acti\red

Ell]::’ Minutes

=

'H]::I

Eﬂﬂ:’ SSECOD

::I SSECOM

< Back

Nest >

Cancel

Help

13. Enter the Connection Parameters values.

HP Automation Insight
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14. Click Next. The Custom Parameters window opens.

i) Edit BSAE-JDBC connection i
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15. Click Finish. The Connections List window opens.

#= Connection Panel | 28 |
8| -|a|x| &|w|z| &
Mame . |T1ﬂ:le | Metwork Layer | Datzbase E... | Folder |
Ba Secured IDBC Vertica IDBC |
fﬂ Al_Conne... Secured JDBC Vertica JDBC /
) BSAE-IDBC  Secured JDBC Orade 11 f
P Y
o .
3 Test the connection - "BSAE-JDBC” | 2 |
OK |
The server is responding!
Details = |
Close | Cancel | Help

16. Open the connection and select the test connection icon ( ¥) to test the connection status. Verify
that the connection is working.

17. Associate the BSAE universes with the above connection. Go to File - Import from the Universe
Designer Tool menu.
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Select a universe domain in the repository to see available universes,
Select the universe you want to import, Double-dick to lodk or unlodk
a universe, A graved padlock means someone else has locked the
universe,

Folder: I ;I

¥ Open the selected universes.
Available Universes: Select a Universe Folder

Universe Mame

Available Universe Folders:

o x|

El-a hyid robsashostS7.ind.hp. com: 6400

-G

+-1 Report Conversion Tool Universes
“{_3 webi universes

C:\Users\wadaga\AppDats

18. Select BSAE Universes.
19. Click OK.
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% Select a universe domain in the repository to see available universes. Select the universe you want to import. Double-dick to lock
w or unlock & universe, A grayed padlock means someone else has locked the universe,

Folder:

¥ Open the selected universes
Available Universes:

Universe Name | Locked by |
MA General Universe
SA Compliance Universe
SA General Universe

< i >
Description:
Version 1.12 s
Import Folder: C:\Wsers\vadaga\AppData\Roaming\SAF BusinessObjects\SAP BusinessObjects Enterprise XI 4.0Wniverses
Browse...

oK I Cancel Help

£

20. Select the SA Compliance Universe from the Available Universes list.
21. Click Browse under Import Folder.

22. Browse to and then select the Import Folder.

23. Click OK.
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24. Select File > Parameter from the Universe Designer Tool menu. The Universe Parameters

25.
26.
27.
28.
29.

window opens.

Universe Parameters ﬂ

Definition |Summar3-I I Strategies I Controls I SQL I Links I Parameter

The following information identifies the universe, A universe is defined by its
name and database connection:

Mame: I SA Compliance Universe

Description: SA Compliance Universe -

Connection Folder:
[/

Connection:

| ™ BsAE-JDBC
s BSAE-IDBC
% Conversion Audit Connection
™ Click here to|#8 efashion

™ efashion-webi

|

QK Cancel Help h

Select BSAE-JDBC from the Connection pull-down menu.

Select File > Export from the Universe Designer Tool menu.

Click OK.

Repeat Steps 17 to 27 for each imported BSAE universe.

Update the oracle. sbo file on the HP Al core server. Update the oracle. sbo file located in
the path
“/opt/HP/CBI/businessobjects/sap bobj/enterprise xi40/dataAccess/connect
ionServer/jdbc/”

Add the following text in the file under the DataBase tag with name as "Oracle 11".

<JDBCDriver>
<ClassPath>
<Path>$ROOTS$/drivers/java/dbd jdbcwrapper.jar</Path>
<Path>/opt/HP/CBI/businessobjects/sap bobj/enterprise x
i40/dataAccess/connectionServer/jdbc/ojdbc6-11.2.0.3.0.jar</Path>
</ClassPath>
<Parameter Name="JDBC
Wrapper">com.sap.connectivity.cs.java.drivers.jdbc.wrapper.JDBCWrapper<

/Parameter>
</JDBCDriver>
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Restart the SAP BusinessObjects Services on the HP Al Core
Server

After you establish the connection between BSAE and the HP Automation Insight core server, type
the following commands to restart the SAP BusinessObjects services on the HP Al core server:
/etc/init.d/SAPBOBJEnterpriseXI40 stop

/etc/init.d/SAPBOBJEnterpriseXI40 start

Run Migrated Reports

After you have completed importing the BIAR file, establishing the BSAE-JDBC connection and
updating the oracle. sbo file, the BSAE folders can be found in Bl from HP Automation Insight, and
you can view and run your BSAE reports and generate new reports from your BSAE universes.

Note: The BSAE database server must be up and running in order to run or create BSAE reports
from migrated BSAE universes.
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